
Displays the telephone number of the computer you want to connect to. The number displayed is the number you entered when 

you created the connection. To change the number temporarily, you can modify it here. To change the number permanently, use 

your right mouse button to click the connection icon, and then click Properties.

If you modify the number directly, information in the Dial Properties dialog box is ignored.

If you want to use a calling card, or if you are at a different location, click Dial Properties.



Click this to specify how the call will be dialed. This is useful if you want to charge the call to a calling card, use your computer 

from different locations, or add a dial prefix, country code, or area code automatically.



Shows the name of the computer you will connect to when you use this connection.

To connect to this computer, double-click the icon in your Dial-Up Networking folder.



Lists the connections you have set up.

If there are no connections in the list that will enable you to connect to this resource, go to the Dial-Up Networking folder and 

create a new connection.



Provides a space for you to type your user name. This name is used when you log on to the computer you are connecting to.



Provides a space for you to type the password for connecting to this computer (not to the network).

If you don't want to type your password each time you connect, click Save Password.



Specifies whether the computer remembers your password or whether you must type it each time you connect.

The password is saved only for this connection icon and this user name.



Specifies where you are calling from. 

To change information about a location or define a new location, click Dial Properties. 

To change to a different location, select one from the list.

If this box and the Dial Properties button are unavailable, close this dialog box, right-click the connection, and then click 

Properties. Then select the Use City And Area Code check box.



Provides a space for you to type or select the area code, phone number, and country code for the computer you are connecting 

to.

You can specify that you want to ignore the area code and country code by making sure the Use Country Code And Area Code 

check box is not selected. When this box is cleared, you cannot specify that you want to dial from a different location when you 

try to connect.



Lists the ISDN adapters or modems that are set up on your computer. To select the modem or ISDN adapter you want to use for 

this connection, double-click it.

If the modem or ISDN adapter you want isn't on the list, double-click the Modems icon or ISDN icon in Control Panel to add it.



Click this to change the settings of the modem or ISDN adapter that you are using to establish the new connection.

Changing these settings for this connection does not affect overall modem or ISDN adapter settings in Control Panel. These 

settings are used only with this connection.



Click this to select the type of dial-up server to use.

Note that changes to the server type do not apply to a connection that is currently open.



Lists the types of servers available, as determined by the dial-up adapter installed on this computer.

Note that changes to the server type do not apply to a connection that is currently open.



Specifies whether incoming or outgoing information is compressed before it is sent. This is useful to speed up the transfer of 

information.

Compression occurs only if both computers are using compatible compression.



Specifies that only encrypted passwords can be sent to or accepted by your computer. This is useful if you need additional 

security for this connection. If you are dialing out, type your password in regular form; your computer encrypts it for you. The 

computer you are connecting to must support encrypted passwords for this option to take effect.



Specifies that Dial-Up Networking will attempt to log on to the network you are connecting to, using the username and password 

you typed when you logged on to Windows.



Specifies the network protocols that your computer can use. 

To add or remove one of these protocols, double-click the Network icon in Control Panel, and then click Add, or click a protocol in 

the list and then click Remove.



Click this to change the TCP/IP settings exclusively for this connection. This is useful if you have different TCP/IP configurations 

for different connections.



Specifies whether Dial-Up Networking will accept an IP address from a PPP server. If the PPP server does not offer an IP 

address, the IP address specified for TCP/IP -> Dial-Up Adapter in the Network properties in Control Panel will be used. 



Provides a space for you to type the preferred IP address for this connection. Dial-Up Networking tries to use this address. 

This is useful if you have more than one Internet account and want to use different IP addresses for different connections.



Specifies whether Dial-Up Networking will accept DNS and WINS server addresses from a PPP server. If the PPP server does 

not offer DNS and WINS addresses, DNS and WINS server addresses specified for TCP/IP in the Network properties in Control 

Panel are used. 



Provides a space for you to type one or two DNS and/or WINS server addresses to use for this connection only. Dial-Up 

Networking tries to use these addresses first.

This is useful if you have more than one Internet account and need to use different DNS and WINS server addresses for different 

connections.



Specifies whether Dial-Up Networking uses IP header compression for this connection. IP header compression optimizes data 

transfer between computers.



Specifies whether IP traffic is routed to the WAN connection by default. 



Dials the specified phone number and connects to the computer you're dialing.



Specifies whether Windows redials the connection if the line is busy or doesn't answer, or if the connection is disrupted. 



Specifies how many times Windows redials a connection after failing to connect.



Specifies the interval, in minutes and seconds, between each redial attempt.



Specifies whether Windows prompts you to use Dial-Up Networking each time you establish a connection. 

This is useful if you want to assign a drive letter to a drive to which you are connected.



Displays information about the device that you have set for this connection.



Provides a space for you to type the phone number that will be used to connect to the Internet service provider (ISP) or remote 

computer. The number displayed is the number you entered when you created the connection.

If your ISP has a different phone number for additional devices to use, you can configure your connection to use it. To configure 

additional devices for use with this connection, click Settings.



Specifies the modem or ISDN line you are using as the primary device for your connection to this computer. To configure the 

device, click Configure.



Click this to configure the modem or ISDN adapter you are using for your primary device.



Displays the number of additional devices available that you can use for this connection. To set up this connection to use 

additional devices, click Settings.



Click this to set up this connection to use additional devices.

Note that changes do not apply to a connection that is currently open.



Specifies that you do not want to use additional devices for this connection.



Specifies that you want this connection to use additional devices. 



Displays the list of additional devices that are currently set up for this connection.



Click this to add extra devices to this connection.



Click this to remove a device that you have selected from the list. 

To select a device, click the device number.



Click this to edit the settings for a device that you have selected.

To select a device, click the device number.



Specifies the modem or ISDN line used by this device. To change the modem or ISDN line, select a new one from the list.



Provides a space for you to type the phone number that is being called on this device. If your Internet service provider or remote 

computer has a secondary phone number for additional devices, type that phone number here.

If you are not sure whether your Internet service provider or remote computer has a secondary phone number available for 

additional devices, contact the administrator for that computer.



Shows more information about your connection.



Specifies that you do not want to see this message again.



Hangs up this connection.



Stops data from traveling over additional devices. 



Displays a list of the networking protocols being used over this connection.



Displays a list of additional devices used in this connection.



Shows or hides details about your connection.



Direct Cable Connection Troubleshooter

This troubleshooter will help you identify and solve Direct Cable Connection problems. Just click to answer the questions, and 

then try the suggested steps to fix the problem.

Before you begin this troubleshooter, make sure you have connected the cable securely at both ends and you have run Direct 

Cable Connection to set up the software.

What kind of connection problem are you having?

              I don't know how to set up the connection software.  
              The connection fails.  



Run Direct Cable Connection

You first need to set up the software for cable connection on both computers. Start on your main (host) computer. The Direct 

Cable Connection wizard will prompt you to move to your other (guest) computer after you have finished setting up the host.

To start Direct Cable Connection

1 Click the Start button, point to Programs, point to Accessories, and then click Direct Cable Connection.

2 Follow the instructions on the screen.

              It's working now. Close the troubleshooter.  
              I already did this. Go back to the beginning of the troubleshooter.   



Did you set up one computer as the host and the other as the guest?

              Yes.  
              No, they are both hosts or both guests.  



There must be a host computer and a guest computer

You need to run the Direct Cable Connection wizard again on one of the computers to set it up as the guest, if the other 

computer is the host (or vice versa).

Did this fix the problem?

              Yes, it's working now. Close the troubleshooter.  
              No, it still doesn't work.  



Did you enable file and print sharing on the host computer?

              Yes, sharing is enabled.  
              I don't know.  
              I need access to the network only through the host computer.  

Note
If you are trying to connect to the network only through the host computer, then sharing does not need to be enabled.



Check whether file and print sharing is enabled

1 Click here        to display Network properties for this computer.

2 Click File And Print Sharing.

3 Make sure that both check boxes are selected.

4 Restart your computer.

If this problem is not fixed, start this troubleshooter again and come back to this topic.

Did this solve the problem?

              Yes, I can connect now. Close the troubleshooter.  
              No, the connection still doesn't work.  



Make sure you are sharing something on your host computer

It is possible that you are connected but that no folders or printers have been shared. In addition to enabling file and print 

sharing, you also have to share the folder on the host computer that you want to open on the guest computer. 

To share a folder

1 In My Computer, click the folder you want to share.

2 On the File menu, click Sharing.

3 Click Shared As.

4 Specify the sharing properties.

Tip
For Help on an item, click 

    at the top of the dialog box, and then click the item.

Did this solve the problem?

              Yes, I can connect now. Close the troubleshooter.  
              No, the connection still doesn't work.  



Check for a possible protocol conflict

The two computers might be using mismatched protocols. Both computers should have at least one common protocol installed, 

depending on the type of access needed by the guest computer. 

What kind of file access does the guest computer need?

              I only need to transfer files that are on the host computer.  
              I need full network access through the host computer.  



A protocol is a language that computers use when communicating over a network. Two computers must use the same protocol to 

communicate with each other. 

For example, if one computer is exclusively using an IPX/SPX-compatible protocol, and the other is exclusively using Microsoft 

NetBEUI, the connection will not work correctly.



The two computers must share a common protocol

Microsoft IPX/SPX-compatible protocol for Windows supports transferring files from the host computer to the guest computer. 

To add a protocol

1 Click here        to display Network properties for this computer.
2 If you need to add a protocol to match the other computer, click Add, click Protocol, and then click Add. 
3 Follow the directions in the Select Network Protocol dialog box.

Did this fix the problem?

              Yes, it works now. Close the troubleshooter.  
              No, it still doesn't work.  



Make sure Microsoft NetBEUI is installed on both computers

To gain server access through the host computer, you must install Microsoft NetBEUI on both computers, in addition to the 

IPX/SPX-compatible protocol. 

To add a protocol

1 Click here        to display Network properties for this computer.
2 If you need to add a protocol to match the other computer, click Add, click Protocol, and then click Add. 
3 Follow the directions in the Select Network Protocol dialog box.

Did this fix the problem?

              Yes, it works now. Close the troubleshooter.  
              No, it still doesn't work.  



Make sure that the protocols are bound correctly

Protocols used for Direct Cable Connection must be bound to the Dial-Up Adapter. Typically, Windows does this automatically 

when a protocol is added, but if for some reason it doesn't, you can bind it manually.

To bind a network adapter to a protocol

1 Click here        to display Network properties for this computer. 

2 In the list of installed network components, click Dial-Up Adapter, and then click Properties.

3 Click the Bindings tab.

4 Make sure that the check boxes are selected for the protocols that both computers will be using.

Did this fix the problem?

              Yes, it works now. Close the troubleshooter.  
              No, it still doesn't work.  



What kind of cable are you using?

              Serial cable.  
              Parallel cable.  
              I don't know.  



What kind of serial cable are you using?

You need a serial, null-modem, RS-232 cable for a direct cable connection. If you are using another type of cable, such as a 

LapLink serial cable, the connection will not work correctly.

Did replacing the cable fix the problem?

              Yes, close the troubleshooter.  
              No, it still doesn't work.  
              I need to buy a new cable.  



Check the type of parallel cable

1 Make sure that you chose the parallel cable option on both computers when you ran the Direct Cable Connection wizard.

2 Check to see what type of parallel cable you are using. 

Windows supports three types of parallel cables for a direct cable connection:
Standard or basic 4-bit cable
ECP cable
UCM cable

Did this fix the problem?

              Yes. Close the troubleshooter.  
              I need a new cable.  
              I have the right cable, but it still doesn't work.  



Includes all LapLink and InterLink parallel cables. 



An ECP (Extended Capabilities Port) cable will work if both computers have ECP-enabled parallel ports, which must be enabled 

in the BIOS. 

Data transfer over an ECP cable is faster than over a standard 4-bit cable and is comparable to a UCM (Universal Connection 

Module) cable.



A UCM (Universal Connection Module) cable can switch into ECP (Extended Capabilities Port) mode if both computers have 

ECP-enabled parallel ports. 

Data transfer over a UCM cable is faster than over a standard 4-bit cable, and is comparable to an ECP cable. 



Cable definitions

Click one of the cable types below to see a description:

Serial

Parallel

Which type are you using?

              Serial  
              Parallel  



A parallel cable fits into a parallel port on your computer (labeled LPT1 or LPT2). A parallel port is commonly used for a printer 

cable and typically has a 25-pin connector. If the cable you are using looks the same as your modem cable, it is a serial, not a 

parallel, cable.

A parallel cable transmits data simultaneously over multiple lines. This makes it the faster of the two connection methods, but it 

can transmit data only over short distances. 



A serial cable fits into a serial port (usually called COM1 or COM2). A serial port is commonly used for a modem cable and 

typically has a 9-pin connector. If the cable you are using looks the same as your printer cable, then it is a parallel, not a serial, 

cable.

A serial cable transmits data sequentially over one pair of wires. It is slower than a parallel cable, but it can transmit data over 

long distances, including over phone lines. 



 To order a new cable

Direct Cable Connection cables are available from several sources.

Parallel Technologies Direct Parallel Cables

Phone (800) 789-4784    from inside the U.S.

Phone (206) 869-1119 from outside the U.S.

Your local dealer
Phone (206) 869-1119 for a dealer near you.
Via e-mail
SALES@LPT.COM (Internet)
71612,3466 (CompuServe)

              OK. Close the troubleshooter.  
              Go back to the beginning of the troubleshooter.   



Next steps

You have encountered a problem that the Direct Cable Connection Troubleshooter cannot help you solve. For more information, 

consult the documentation that came with your computer or the vendor from whom you purchased the cable.

              Go back to the beginning of the troubleshooter.   
              Close the troubleshooter.  



To set up a network connection by using Dial-Up Networking

1 Double-click the My Computer icon, and then double-click Dial-Up Networking.

2 Follow the instructions on the screen.

Notes

If you have already set up one or more Dial-Up connections, you can double-click Make New Connection to create a new 
connection. To dial a connection that you have already set up, double-click its icon in the Dial-Up Networking window.

After you have connected to another computer, you can see files and folders on that computer only if they are shared. 
If you do not see a Dial-Up Networking folder in My Computer, then it is not installed. To find out how to install it, click 

Related Topics below.

{button ,AL("A_ADDPROG_COMPONENT;A_RNA_CHANGE_SETTINGS;A_RNA_CHANGE_DIALIN_SETTINGS")} Related 

Topics



To change dialing settings for all Dial-Up connections

1 Double-click the My Computer icon, and then double-click Dial-Up Networking.

2 Click the connection whose settings you want to change.

3 On the Connections menu, click Settings.

Tip

For Help on an item, click 
    at the top of the dialog box, and then click the item.

{button ,AL("A_DIAL_LINK;A_RNA_CHANGE_SETTINGS")} Related Topics



To change the properties for a Dial-Up connection

1 In the Dial-Up Networking folder, click the icon for the connection whose properties you want to change.

2 On the File menu, click Properties.

3 Click Configure.

4 Make changes to the modem properties.

Changes that you make will take effect when you gain access to a shared resource that uses this connection, or the next time 

you double-click the icon for this connection.

Tips

To change the type of server that you are dialing in to, or to specify which protocols this connection uses, click the Server 
Type tab.

You can change settings only if you have already set up a connection.
For Help on an item, click 

    at the top of the dialog box, and then click the item.

{button ,AL("A_DIAL_LINK;A_RNA_CHANGE_DIALIN_SETTINGS")} Related Topics



To set up a direct cable connection

1 Click the Start button, point to Programs, point to Accessories, and then click Direct Cable Connection.

2 Follow the instructions on the screen.

Notes

If you have already successfully run Direct Cable Connection on this computer, the connection wizard does not appear 
unless you click Change in the Direct Cable Connection dialog box. The wizard then starts and you can change your previous 
settings.

If you do not see Direct Cable Connection in your Accessories menu, then it is not installed. To find out how to install it, 
click Related Topics below.

{button ,AL("A_ADDPROG_COMPONENT;A_DCC_SETTINGS;A_DIAL_LINK_CABLE;A_RENEW_DCC")} Related Topics



To re-establish a direct cable connection that is already set up

1 On the host computer, click the Start button, point to Programs, point to Accessories, and then click Direct Cable Connection.

2 Click Listen.

3 Move to the guest computer, and then repeat step 1.

4 Click Connect.

Note

If you have trouble connecting, check the cable, or run the Direct Cable Connection Troubleshooter in Help.

{button ,AL("A_DCC_SETTINGS;A_DIAL_LINK_CABLE;A_SETUP_DCC")} Related Topics



To change settings for a direct cable connection

1 Click the Start button, point to Programs, point to Accessories, and then click Direct Cable Connection.

2 Click Change.

3 Make any necessary changes. These changes will take effect when you gain access to a shared resource that uses this 

connection.

{button ,AL("A_DIAL_LINK_CABLE;A_SETUP_DCC;A_RENEW_DCC")} Related Topics



Shared resources include files, folders, and printers.



To dial a connection manually

1 Double-click the My Computer icon, and then double-click Dial-Up Networking.

2 Click the icon for the connection you want to change.

3 On the File menu, click Properties.

4 Click Configure.

5 On the Options tab, click Operator Assisted or Manual Dial.

6 When you gain access to a shared resource that uses this connection, or the next time you double-click the icon for this 

connection, you will be prompted to lift the receiver of your phone and dial the number.

7 When you hear the tone from the computer, click Connect, and then hang up the phone.

Tip

For Help on an item, click 
    at the top of the dialog box, and then click the item.



To disconnect a Dial-Up Networking connection

Right-click the icon on the toolbar, and then click Disconnect.



To use Dial-Up Networking to connect to another operating system

1 In the Dial-Up Networking window, create a new connection to the computer you want to dial in to.

2 After you have created the connection, right-click the icon for that connection, and then click Properties.

3 On the Server Type tab, select the type of dial-up server that matches the operating system you want to connect to.

Tips

If the other operating system requires you to type in information when you log on, click the Configure button in the 
properties dialog box for that connection, click Options, and then click Bring Up Terminal Window Before Dialing.

For Help on an item, click 
    at the top of the dialog box, and then click the item.



To use a different IP or DNS address for a dial-up connection

1 In the Dial-Up Networking window, click the connection that you want to assign the new IP address to. 

2 On the File menu, click Properties.

3 On the Server Type tab, click TCP/IP Settings.

4 Type the new IP and/or DNS address in the space provided.

Notes

This setting is useful if you have more than one Internet account and cannot use the same address for all of them.
If you click Server Assigned IP Address or Server Assigned Name Server Addresses, Dial-Up Networking uses the default 

TCP/IP address information for this connection, as specified in the Network properties in Control Panel.



Setting up your computer to use ISDN

Click here 

    to go to the Microsoft Get ISDN Web site, where you can learn more about ISDN and place an order request for an ISDN line 
with your phone company.

Notes

You must have Internet access to connect to this site.
The Internet address of this site is http://www.microsoft.com/windows/getisdn/ .



ISDN is a high-speed digital telephone service that can dramatically increase the speed at which you connect to the Internet or to 

your corporate LAN (local area network). ISDN can operate at speeds up to 128 kbps, which is five or more times faster than 

today's analog modems.



You have successfully made a connection by using Dial-Up Networking.

To disconnect or to view status information, double-click the  icon in the status area of the taskbar.

What to do next

· If you have connected to your Internet service provider, you can use Internet programs, such as a Web browser.

· If you have connected to a computer running Windows 95 and want to access shared folders on that computer, click the Start 

button, point to Find, click Computer, and then type the name of that computer.

· If you have connected to a local area network (LAN), you can gain access to resources on that LAN by using Network 

Neighborhood.



Dial-Up Networking Troubleshooter

This troubleshooter will help you identify and solve problems with Dial-Up Networking. Just click to answer the questions, and 

then try the suggested steps to fix the problem.

What's wrong?

              I can connect to the remote computer, but I do not see a terminal screen.   
              I can connect to the remote computer, but the remote computer hangs up right after answering the phone.  
              Dialing doesn't work correctly.  
              The remote computer hangs up unexpectedly.  



Try your call again 
You may be experiencing line noise or cable problems. Try your call again.

Did this fix the problem?

              Yes, I was able to connect. Close the troubleshooter.  
              No, I'm still having trouble.  



What kind of connection are you using?

              SLIP or PPP.  
              Windows for Workgroups or Windows NT 3.1.  



Bring up a terminal window 

1 In the Dial-Up Networking window, click the connection you are creating a terminal screen for.

2 On the File menu, click Properties. 

3 Click Configure. 

4 Click the Options tab, and then make sure that the Bring Up Terminal Window After Dialing check box is selected. 

5 Try your call again. 

Did this fix the problem?

              Yes, I was able to reconnect. Close the troubleshooter.  
              No, I'm still having trouble.  



Use Connect Network Drive

Dial-Up Networking doesn't show a terminal screen. Use Connect Network Drive to gain access to shared files and folders on the 

remote computer.

              OK. Click here to close the troubleshooter.  
              Click here for information about connecting to shared files and folders.  



Contact the computer's administrator

You might have gone too long without typing anything, or your account might limit how long you can be connected to the 
computer. Try the call again, and ask the administrator for the remote computer whether your time limit can be increased. 

Did this fix the problem?

              Yes, I was able to reconnect. Close the troubleshooter.  
              No, I'm still having trouble.  



Contact the computer's administrator

Find out whether the computer is working correctly. It might have been shut down for maintenance. 
              OK. Click here to close the troubleshooter.  
              Click here to return to the beginning of the troubleshooter.  



Bring up a terminal window 

1 In the Dial-Up Networking window, click the connection you are creating a terminal screen for.

2 On the File menu, click Properties. 

3 Click Configure. 

4 Click the Options tab, and then make sure that the Bring Up Terminal Window After Dialing check box is selected.

5 Try your call again. 

Did this fix the problem?

              Yes, I was able to reconnect. Close the troubleshooter.  
              No, I'm still having trouble.  



Does the remote computer prompt you for a password?

              Yes.  
              No.  



Make sure you're using the correct password

Make sure the password you are using to log on to the remote computer is correct. If it has changed or expired, or if you 
have forgotten the password, contact the administrator for the remote computer to get a new password. Then try the connection 
again.

Did this fix the problem?

              Yes. Click here to close the troubleshooter.  
              No, I'm still having trouble.  



Make sure you have access to the remote computer

If the remote computer is set up for user-level access control, contact the administrator for the computer to make sure you 
have access to it. Then try the connection again.

Did this fix the problem?

              Yes. Click here to close the troubleshooter.  
              No.  



Contact the remote computer's administrator

You've run into a problem with the remote computer that the Dial-Up Networking Troubleshooter can't help you solve. 

For more information, contact the administrator for the remote computer. 

              Go back to the beginning of the troubleshooter.  
              Close the troubleshooter.  



Automating a Dial-Up Networking connection

You can create a Dial-Up Networking script to automate the process of connecting to an Internet service provider, online service, 

or remote computer. 

To begin creating a Dial-Up Networking script, click a button below. For an overview of scripting, click Overview Of Scripting For 

Dial-Up Networking.

              Create a script file.  
              Assign a script file to a Dial-Up Networking connection.  

              Overview of scripting for Dial-Up Networking  



Overview of scripting for Dial-Up Networking

Many Internet service providers and online services require you to enter information, such as your user name and password, to 

establish a connection. You can create a Dial-Up Networking script that provides this information automatically, so you do not 

need to type it each time you connect. 

To create a Dial-Up Networking script, you use a text editor, such as Notepad, to create a script file, and then you use the Dial-

Up Scripting Tool to assign the script file to a Dial-Up Networking connection you have established.



To create a script file

1 Click here        to start WordPad.

2 In the folder that contains your Windows program files, open the Script.doc document. 

This document describes the Dial-Up Scripting command language that you need to use to create your script file.

3 Click here        to start Notepad.

Or open a new file in another text editor.

4 Type the scripting commands that provide the information required by your Internet service provider, online service, or the 

computer you want to connect to. Refer to the Script.doc document, if you need to.

5 Save the file using any name. 

Tips

To make it easy for the Dial-Up Networking Scripting Tool to find the file, save it to your Accessories folder, and use 
the .scp extension.

For easy reference, you might want to print Script.doc. To print it, click the File menu, and then click Print.

What's next?

              Assign a script file to a Dial-Up Networking connection.  



To assign a script file to a Dial-Up Networking connection

1 Click the Start button, point to Programs, point to Accessories, and then click Dial-Up Networking.

2 Click the connection you want to assign the script file to.

If you haven't created a connection, double-click the My Computer icon, and then double-click Dial-Up Networking. For more 

information, click Related Topics below.

3 On the File menu, click Properties. 

4 Click the Scripting tab. 

5 In the File Name box, type the location and file name of the script file, or click Browse to find the file.

{button ,AL("a_rna_dialup")} Related Topics



A script file contains scripting commands, parameters, and expressions that provide and retrieve information to and from the 

remote computer you are connecting to. This information includes your user name and password, port information, carriage 

returns, line feeds, and pauses. 

For information about how to use the Dial-Up Scripting command language to create a script file, use WordPad to open the 

Script.doc file. This file is located in the folder that contains your Windows program files.



An Internet service provider maintains a server that is directly connected to the Internet. You must connect through a service 

provider or MSN (The Microsoft Network) unless your organization is directly connected to the Internet. 



Lists the Dial-Up Networking connections that you have created. Select the connection you want to assign a script to.



Click this to view the properties for the selected connection. You can make any changes you want to the properties.



Provides a space to type the location and filename of the script you want to assign to the selected connection. If you don't know 

the location or filename of the script, click Browse.



Click this to find the script file you want on your computer.



Click this to edit the specified script file by using Notepad.



Enables you to run the script one command at a time while establishing the connection. This is useful if you want to check your 

script for errors.



Minimizes the terminal window that displays information as it is sent to and received from the remote computer. If you want to 

view the information as the script is running, make sure this check box is clear.



Displays a Help topic that describes the commands you can use to create a script file. 



Displays the script file assigned to the current connection. To run the script one command at a time, click Step.



Runs the script one command at a time. This is useful for checking your script for errors.



Displays information that is being sent to and received from the remote computer. 

If the Allow Keyboard Input check box is selected, you can send information to the remote computer by typing it here.



Enables you to send information to the remote computer directly by typing it in the terminal window. This is useful if you need to 

halt your script and provide information to the remote computer manually.



Continues establishing the connection. 




